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Welcome to Servers Alive, the award winning monitoring tool from
Woodstone bvba. Servers Alive is designed to monitor many different
types of servers and services from a central location and report their
status. Servers Alive supports many generalized tests applicable to
servers of all types, along with specialized tests for certain types of
services. When Servers Alive detects that a server or service has become
unavailable, Servers Alive can report this condition in a variety of ways.
The software can even take care of the problem without any human
interaction.

Servers Alive is used all over the world by companies in all types of
businesses, from computer to legal, military to government. The
companies rely on the software to monitor their mission critical servers.

Servers Alive is a compact and inexpensive tool, but it packs a lot of
punch. It has a feature set that compares favorably with the most popular
monitoring packages available, but sells for a fraction of the cost. You
can register the product and then you can check up to 1000 entries with
the Standard edition and up to 5000 with the Enterprise edition.

We're sure you'll enjoy your experience with Servers Alive. As such, we
offer the product free to those who only wish to monitor ten or less
servers or services. We're confident you'll see the incredible worth you
can get out of this amazing product!

In This Chapter

What's New? ......................................................................2
Installation..........................................................................4
Getting Started in the Main Window ................................. 7
Default Host Names...........................................................13
License Agreement.............................................................14
Technical Support .............................................................. 16
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Installation
Servers Alive has the following requirements for installation:

1 Microsoft® Windows® 2000 (Professional or Server edition), NT®
(Workstation or Server edition), XP, and 2003.

2 Network interface card.

3 TCP/IP.

4 Telephony service.

For more information about these requirements, see the online Help for
Windows.

You can purchase two different editions of Servers Alive: Standard and
Enterprise. To find out more, see the Woodstone web site
(http://www.woodstone.nu/salive/purchasev5.asp).

The following table shows the differences between the editions and free
version.

Free
version

Standard
edition Enterprise edition

Entries 10 1000 5000

Logging to ODBC-
compliant database

Yes No Yes

Alert schedules Yes No Yes

On-call schedules Yes No Yes

Schedules for each alert Yes No Yes

RRD Tools Yes No Yes

Custom fields Yes No Yes

Visual Basic scripts Yes No Yes

Network routes for
checks

Yes No Yes

Alert on received SNMP
traps

Yes No Yes

Before Installing Servers Alive

Please note that you must be an administrative user on the computer
before you can install Servers Alive. Also note that, for all operating
systems, you must run the telephony service or the processor can take
100% CPU usage. For more information about telephony services, see the
online Help for Windows.
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Make sure that Windows has been updated to include the most recent
patches provided by Microsoft®. This ensures the best possible
compatibility. If you plan to use Servers Alive to check Oracle® or
Microsoft SQL® databases, you must install the corresponding client
software provided by the database manufacturer, as Servers Alive uses
the client to perform its checks. If you check any Novell®-specific
servers, you must install the Client for Novell Networks provided by
Novell. The Novell client provided by Microsoft is not sufficient for the
Netware® checks.

Downloading Servers Alive

Servers Alive is obtained primarily through an Internet download at the
Woodstone web site (http://www.woodstone.nu/salive/purchasev5.asp).

You can find the download link on that page, or you can choose from any
of the worldwide mirrors.

Woodstone bvba can ship a CD to you when you purchase the full
version of the software. Only one version of the software exists,
regardless of whether you use it for ten or less entries or whether you
have purchased a full license.

Installing Servers Alive

Make a backup of your Servers Alive installation file (.exe).
Woodstone is not responsible for backups of this file.

Once you have downloaded the software package and saved it to a
convenient location, launch the Setup program.

Note that you cannot install Servers Alive through a Terminal Server
session. When running Servers Alive as a service through Terminal
Server, you cannot see the tray icon.

The system tray icon of Servers Alive is visible only on the desktop of
the system running Servers Alive. If the software is running as a service,
you can only see the icon when the service user interacts with the
desktop. Note that a Terminal Server session does not display the actual
desktop, but a virtual desktop. Also, you can see the actual desktop if you
use the terminal server session with the /CONSOLE command line
option of the Terminal Service client of Windows 2003 and Windows
2003 server. This applies to Windows 2003 or newer.

The Setup program asks you for a location where it can install the
software. You can install the software in any location. The install
program extracts all program files to the location you specify and creates
entries for Servers Alive on your Start Menu under the heading Alive.

Servers Alive can be run as a service if the computer for installation is
running Windows NT, 2000, XP, or 2003. The Setup process detects your
operating system and the service automatically installed. For Servers
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Alive to start automatically when you turn on your computer, you must
go to the Services control panel and set the service called Servers Alive to
automatic startup.

Extending Servers Alive

When the Setup program installs Servers Alive, the Setup program also
installs a few companion applications that you can use to extend the
functionality of Servers Alive. A subdirectory called External includes
sample external check applications that you can use. Woodstone bvba
creates and maintains the applications that are included in the external
directory, but there are other applications, made by other authors,
provided free, that you can download from the Woodstone bvba web site.
There are also applications in the main Servers Alive directory that you
can use to create your own external checks. For more information, see
External Checks (page 289).

Configuring Servers Alive

Before adding any monitored entries to Servers Alive, you need to
configure its various options and features. Servers Alive has many
powerful features that you can use to tweak the monitoring process. You
should configure these before adding any entries, as you cannot use most
of the alerting or monitoring features without globally configuring them
first.

The first thing to do is enter your registration code if you purchased the
product. You can do this by selecting the Register menu option from the
Main window. This menu option is visible only in the unregistered
product. Woodstone bvba sends an email with the required name,
company, and registration Code when you purchase the software. If you
have purchased the product, but do not have a registration code, please
send an email to Servers Alive support (mailto:support@woodstone.nu).

Next, you can click the Setup button on the Main window. You can
configure how Servers Alive monitors and alerts you by setting various
options in the tree.
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Start, Stop, Pause, and Update Buttons

There are four command buttons in the lower right-hand corner of the
Servers Alive window called Start, Stop, Pause and Update. Use these
buttons to control the check cycle. If you pause the check cycle, it stops
where it is and allows you to resume when ready. Note, however, that it
only pauses until the next schedule check cycle, at which time the
software checks entries again automatically. If you need to stop the
check cycle for a long period of time, click the Stop button instead.
When you are ready to resume, use the Start button. When you click the
Update button, the software immediately begins a new check cycle.

To display the status for entries in a group in the Status column of the
Main window, you can click the Setup button and then click General >
Interface Settings in the tree. Click the Show Group Statistics in Tree
Interface check box. The status displayed in the Main window applies
only to the entries in the group—and not subgroups.

Rechecking an Active Entry

You can recheck a single entry that has gone down to verify its condition.
You do this by first clicking the Stop button to stop any check cycle
currently in progress. Select an entry and right-click to select Check
Now. Servers Alive checks that single entry and displays the status in the
left-most column.

Statistics

Servers Alive maintains statistics on the availability of the servers that
you monitor. You can access these statistics by first selecting an entry.
You then right-click and select the Statistics command on the shortcut
menu. The Statistics box displays response time statistics, showing the
minimum, maximum, and average response times. The dialog box also
shows how many times the server was detected as up and down.
Currently, there is no process to produce reports based on this
information.

Servers Alive does not keep previous statistics when you stop and then
restart the software.
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Active and Maintenance Modes

An entry can be in one of two modes: Active or Maintenance. Hosts are
only included in the check cycle if they are active. Most entries stay in
active mode all the time and only can be switched to maintenance mode
when work is being performed on them. If you have regularly scheduled
maintenance periods for a server, you should click the Add button and
use the Schedule tab in the host entry to schedule periods when the item
is switched to maintenance mode.

You can change an entry from active to maintenance states quickly and
easily. Select an entry in the Main window and right-click. You can then
select Active or Maintenance from the shortcut menu.

You can also change all the entries in a group with one click. Select a
group and right-click. On the shortcut menu, click Set All Entries to
Active or Set All Entries to Maintenance.

Sound

If you want to turn off the sound, select an entry and right-click. Select
Mute Sound on the shortcut menu.
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License Agreement
Following are various statements that detail the proper use of Servers
Alive. If you have any questions regarding the following sections, please
contact Woodstone bvba (mailto:legal@woodstone.nu).

The freeware version is limited to checking 10 entries. You can register
the product and then you can check up to 1000 entries, for the Standard
edition, or 5000 entries, for the Enterprise edition.

License Agreement

This license agreement covers your use of the Woodstone bvba Servers
Alive, its executable files and documentation, hereinafter referred to as
the Product.

The Product is copyright © 1997-2006 Woodstone bvba. You may use it
and distribute it according to this following License Agreement. If you do
not agree with these terms you must remove the Product from your
system.

By incorporating the Product in your work or distributing the Product to
others you implicitly agree to these license terms.

This License Agreement covers the current version of the product.
Woodstone bvba reserves the right to modify the terms of this License
Agreement at any time, and without prior notification, in future releases
of the product.

Conditions of Use

The Product is provided in one form: as a ready-to-run installation kit
consisting of executable programs, release notes, and so forth (the
Product Executable).

You may freely use and distribute the Product Executable so long as you
provide the complete and unmodified original Product Executable
installation kit as supplied by Woodstone bvba.

Disclaimer of Warranty

The Product is provided as free software, in the hope that it will be
useful. It is provided "as-is", without warranty of any kind, either
expressed or implied, including, but not limited to, the implied warranties
of merchantability and fitness for a particular purpose. The entire risk as
to the quality and performance of the Product is with you. Should the
Product prove defective, the full cost of repair, servicing, or correction
lies with you. The freeware version is limited to checking 10 hosts. You
can register the product and then you can check up to 1000 entries, for the
Standard edition, or 5000 entries, for the Enterprise Edition.
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Conditions

For commercial distributors, other licensing conditions may be negotiated
with respect to technical support and redistribution rights. Before
reselling Servers Alive, you must contact Woodstone bvba to negotiate a
redistribution license.
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Technical Support

Email

Limited email support is available from Woodstone support
(mailto:support@woodstone.nu).

Full guaranteed technical support is subject to a Woodstone bvba support
license. For current prices and conditions, please send email to
Woodstone support (mailto:support@woodstone.nu).

Mailing List

You can obtain technical information quickly by signing up for our
mailing list. To sign up for the list, see the subscriber page
http://www.woodstone.nu/salive/mailinglist.asp.

You can also search the mail archives http://archive.serversalive.com for
useful information.
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You can run Servers Alive natively as a service in Windows
NT/2000/2003/XP. You must set Servers Alive as a system account with
desktop interaction. To do this, you open the Microsoft Management
Console, select the Local System Account option on the Properties
dialog box, and click the Allow Service to Interact with Desktop
setting.

If you run Servers Alive as a service, using the system account with
desktop interaction, you see the system tray icon only when you log on to
the real desktop of the system running the service.

Terminal Server Sessions

If you want to use a Terminal Server session to manage Servers Alive
running as a service, you must run Terminal Server for Windows 2003
and the Windows 2003 Terminal Server client.

When using a Terminal Server session, you interact with a virtual
desktop, not the actual, or real, desktop of the remote system. The system
tray icon of Servers Alive is visible only on the real desktop of the system
running the service and only if you are logged in with the correct
privileges as the user of the service. To display the actual desktop of the
system running the service, not the virtual desktop, you must type the
command line option /CONSOLE on the client at the DOS prompt.

The Console option is available only for Windows 2003 Terminal Service
client.

Security Issues with Services Running in Windows

Any services that run in Windows have a common security issue. To run
Servers Alive under the system account with desktop interaction, you
should carefully consider the following: Any process started from within
Servers Alive has the same access rights as the system administrator.

You must protect the system running Servers Alive by ensuring that
only users with a correct security clearance are allowed to log on to the
local system. Remote log-ons have serious security implications. Users
who log on remotely can perform tasks as though they were sitting at
the console. For this reason, you should make sure that the server is
behind a firewall. You should require that all users who use remote
connections log in with a strong password.

C H A P T E R 2

Servers Alive and Terminal Server
Sessions
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For example, an administrator installs Servers Alive on a workstation and
configures the software to run as a service, using the system account with
desktop interaction. A non-administrative user can log on to the
workstation and see Servers Alive as an icon in the system tray. The user
can open the Servers Alive Help file and click the View Source
command in the Windows Help viewer. Subsequently, in the Open
dialog box, the user can open and run CMD.exe. The non-administrative
user can now run the command line with all the access rights as the
system administrator.

Members of the Server Operator group can list, monitor, and restart
services.

Remote Windows NT or 2000 Systems

When you run Servers Alive as a service in Windows NT or 2000, using
the System account with desktop interaction, you can perform checks.
Consider the following example: The System account of host_1 has no
rights to host_2; and you cannot assign rights to it. However, you can still
check services, processes, or diskspace on the remote Windows NT or
2000 system. To do this, you should specify a user name and password
for each of the checks.

If the host is part of a domain, you should include the domain name with
the user name as in: domain_name\user_name.
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Enable Primary SMTP Mail

Enables this feature and allows you to enter values on the dialog box. If
you do not click this box, the software sends mail through both the
primary and alternate SMTP servers.

Mail Host

Enter the mail host as a NetBIOS name, DNS name or IP address; for
example, HERMES, mail.domain.com, or 123.45.67.89.

Send Direct

Click this check box to send the alert message directly to the mail server
that is responsible for the domain in the To box of the message. If you
select DUN options and click the Send Direct check box, Servers Alive
sends the DNS request for the MX record before making the DUN
connection. For more information about DUN options, see Advanced
Settings for the SMTP Primary Tree: DUN and ESMTP (page 24).

When you click the Send Direct check box, with certain versions of the
IPHLPAPI.DLL file, you must specify the DNS servers to use when
querying for the MX records in the following registry key. If you do not
specify the DNS servers, Servers Alive attempts to determine which DNS
servers to use.

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\SMTP\Primary_DNS_to_use (string)

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\SMTP\Primary_DNS_to_use_2 (string)

If the first DNS server does not respond correctly, the software uses the
second DNS server, if specified, to get the MX record for the recipient
domain.

From

Enter a name or a fully-qualified domain name; for example,
serversalive@company.com. Your entries depend on the way your SMTP
server is configured; most SMTP servers require a FROM name that
looks like a valid email address, such as salive@domain.com. If you
have trouble, please contact your mail server administrator for the
appropriate settings.

If you do not enter correct information in the From box, you might
receive a message from the mail server indicating that relaying has been
denied.
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Priority of Mail

Select one of several different levels of priority for sending the message.

Don't Ping the SMTP Servers Before Sending Mail

Prevents Servers Alive from pinging the server before sending the alert
message. If the check box is clear, Servers Alive pings the SMTP server
to see if it is responding before the software sends the email.

Fall Back to Alternate When Primary Not Responding Correctly

Check so that the alternate server is used only when the primary server is
down or not responding correctly.

Test It

Sends a test message to the specified users. Remember to click the Apply
button first; otherwise, Servers Alive uses the previous values for the test
mail. Messages about the results of the test appear next to the Test It
button.

Advanced Settings for the SMTP Primary Tree: DUN and ESMTP

Servers Alive also supports ESMTP and POP3 authentication. ESMTP
authentication is limited to AUTH LOGIN, a clear text authentication
method using a base-64-encoded user name and password.

Servers Alive uses your LAN (network) connection to send the mail to
your SMTP server. Servers Alive can also do this using DUN (Dial Up
Networking).

Servers Alive sends SMTP mail through your usual LAN connection
(__LAN__). You can, however, force Servers Alive to dial into a remote
network before sending mail to an SMTP server. To do this, you first
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must configure the correct Dial-up Networking settings in Windows.
You can then select them using the appropriate dropdown boxes on the
DUN-SMTP branch of the tree. If you need to provide a user name,
password, and domain to establish the connection, you can enter them in
the appropriate text boxes.

Many organizations do not allow standard SMTP connections for
outgoing mail, as outside spammers use them to send unsolicited mail.
Most have an option to use ESMTP, which forces a person to log in to the
SMTP mail server before allowing that person to send any mail. If your
company uses ESMTP, you must supply a use name and password
combination for your primary and/or alternate mail settings to allow
Servers Alive to send mail.

To use this, select ESMTP or POP3 in Use Authentication, and then
type the user name and password.

DUN Entry to Use

Select whether to use the local area network or dial-up network. By
default, Servers Alive connects to the host using the normal LAN
connection (__LAN__). Additionally, Servers Alive can also create a
dial-up network (DUN) connection to an external network before
completing the check. After the check, Servers Alive disconnects from
the external network. If you have created dial-up network connections on
your computer, those connections appear on the DUN Entry to Use
dropdown list.

The DUN feature is available only if a dial-up network connection is
installed on the computer running Servers Alive. See the online Help for
Windows for more information on how to create a dial-up network
connection. To use this feature effectively, Servers Alive must make the
connection completely unattended. For that reason, you must configure
the dial-up entry to save passwords.

Username

Enter the user name required to log in to the network.

Password

Enter the password required to log in to the network.

Domain

Enter the name of the domain.

Use authentication

Select to use ESMTP or POP3 authentication. You can also select to not
use authentication. If you click ESMTP, this type of authentication is
limited to AUTH LOGIN type, a clear text authentication method using a
base-64-encoded user name and password.
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Username

Enter the user name required for authentication.

Password

Enter the password required for authentication.

POP3 Server

Type the name of the POP3 server.

Reset

Resets the counter that tracks the number of messages that the alert sends
when completing a check. You can view the number of messages sent
since the last time that you clicked the Reset button.

Registry Settings for SMTP

Ping Settings

Before sending an e-mail, Servers Alive pings the SMTP server to see if
it is responding. You can use the following SMTP\PingTimeout
parameter to determine the amount of time Servers Alive should wait for
a response (max. 32 sec).

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\SMTP\pingtimeout (dword)

Servers Alive can send you an email every few minutes, based on the
interval that you choose, to show that the software is still running. The
mail is sent using the default settings of the primary SMTP server. When
Servers Alive starts or stops checking, it can also send an email, using the
settings of the primary SMTP server. Before sending email to an SMTP
server, Servers Alive pings the server and only sends email to the server
if it gets a response. If your server is not responding to pings, because a
router or fire wall filters out the ICMP packages, the email is not sent.
You can disable this ping-before-send feature to get around this. All
email sent by Servers Alive is by default sent as URGENT email (high
priority).

By default, the keep-alive mailings are sent to the default primary Mailto
parameter. This can be altered with the following registry key.

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\SMTP\KeepAliveTo (string)

SMTP Timeout

Another parameter called SMTP\Timeout controls how long Servers
Alive waits for the SMTP server to respond. The default is 15 seconds,
and the maximum is 60 seconds.
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Size of Body Text

You can limit the size of the body text by editing the following registry
entries. This value does not count the size of the additional footers or the
"main generated" section.

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\SMTP\Primary_max_size (string)

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\SMTP\Alternate_max_size (string)

Alternate (Setup Dialog Box)

For more information about the advanced settings, see Advanced Settings
for the SMTP Primary Tree: DUN and ESMTP (page 24).

Enable Alternate SMTP Mail

Enables this feature and allows you to enter values on the dialog box. If
you do not click this box, the software sends mail through both the
primary and alternate SMTP servers.

Mail Host

Enter the Mail Host as a NetBIOS name, DNS name or IP address; for
example, HERMES, mail.domain.com, or 123.45.67.89.

Send Direct

Click this check box to send the alert message directly to the mail server
that is responsible for the address in the To box of the message.

When you click the Send Direct check box, with certain versions of the
IPHLPAPI.DLL file, you must specify the DNS servers to use when
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Numeric Paging (Setup Dialog Box)

You must install a modem in Windows to use this feature.

You must enable paging on a host-by-host basis. By default, you are not
paged by any hosts when a DOWN condition is detected. Because
numeric paging is not based on a standard protocol, numeric paging is not
as reliable as alphanumeric paging.

Enable Pager

Enables Servers Alive to send you alerts through an attached modem to a
numeric pager.

Phone Number

Specify a phone number of your numeric pager to which Servers Alive
can send a message.

End Message Indicator

After a numeric message has been entered, specify an end-of-message
indicator. Generally paging providers use # as the indicator.

Wait String

Specifies the wait time for Servers Alive. In most cases, after dialing the
phone number of your pager, Servers Alive must wait several seconds
before sending out the numeric information. You can enter a time in the
Wait box as a number of commas. Every “,” represents about 2 seconds.
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Add 0 When Down and 1 When Back Up to Host-id

Check this option to receive extended information on your page. Servers
Alive adds a -0 for a down host to the host ID and a -1 for an up host to
the host ID. Numeric paging is unreliable because it is not based on any
standard protocol.

The message that you get on your pager displays a number. This number
is the Host ID, which you can change when creating or editing a host.

If you select the Add 0 When Down and 1 When Back Up to Host-id
option, Servers Alive sends a "-" (dash) between the host ID and the 0/1
(down/up). You can change this if you add or edit the following registry
value:

HKEY_LOCAL_MACHINE\SOFTWARE\DBUConsulting\Servers
Alive\Pager\Separatorstring (string)

Port to Use

Specifies the COM port to which your modem is attached. In most cases,
you can enter TAPI. When using TAPI, Servers Alive uses only the
TAPI modem that you installed first.

Test It

Tests the pager. Remember to click the Apply button first, or Servers
Alive uses the previous settings.

Reset

Resets the counter that tracks the number of messages that the alert sends
when completing a check. You can view the number of messages sent
since the last time that you clicked the Reset button.
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Alpha Paging - SMS (Setup Dialog Box)

The alpha paging feature sends a text-based message to a cell phone or
paging device. You must install a modem in Windows to use alpha
paging. Note that Servers Alive also supports GSM modems using the
AT+C protocol.

One of the most common methods of alerting is alphanumeric paging,
which sends a text-based message to a cell phone or pager device. You
can send small alerts to your alphanumeric pager detailing exactly which
server is down, often with collaborating information. To do this, you
must provide a modem device that allows you to send alphanumeric
pages. The actual paged device or number is added on a host-by-host
basis.

Enable Alpha Paging and SMS Messaging

To turn on this feature, click the Enable Alpha Paging & SMS
Messaging box.

Devices

Configure the device that Servers Alive uses to send the message. Click
the Devices list to choose a modem. This drop down box displays any
modems that you have installed in Windows.

Comm Settings

Enter the communication settings in the Comm Settings box. Contact
your paging/SMS provider for these settings, along with the protocol and
SMSC.

In general, you can try entering 7E1, 7N1, or 8N1. Woodstone bvba
maintains an informal list with settings reported by users of Servers Alive
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for providers around the world. You can find this list at the Woodstone
web site http://www.woodstone.nu/salive/pagersettings.asp. Woodstone
bvba takes no responsibility for the accuracy of the supplied information.

Baud rate

Choose a setting that is appropriate for your service provider.

Devices

SMSC No

Enter the phone number for the modem of your service provider. You can
enter an international format as +1 bbccccccc, such as +1 812123456.

When using an international format, make sure that you include the
space between the country number and the rest of the number. In the
previous example, +1 is the country number. You must also set the
country and area code correctly in the software that comes with your
modem.

When using the AT+C protocol for GSM modems, you do not need to
provide an SMSC number. Servers Alive uses the settings of the attached
GSM modem. You must configure your modem to send SMS messages.

Protocol to Use

Select the protocol used by your provider. This is either TAP, AT+C, or
UCP.

UCP Operation

If your provider uses UCP, you must also specify settings for the UCP
Operation box.

You can view the list at the pager settings page at the Woodstone web
site http://www.woodstone.nu/salive/pagersettings.asp, but the
information might not be listed for your provider or contain up-to-date
settings. Please contact your provider for the correct information.

Message

In the Message section, you must provide authentication information.
This information is available from your provider and is required in order
to send a message.

Sender

Enter the name of the sender for authentication purposes. In most cases,
this can be left blank.
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Receiver

Indicates the name of the destination host.

Port

Indicates the destination port for sending traps. The default standard port
number is 161. However, for security purposes, you can enter a different,
non-standard port number.

Community

Enter a community string to use in the traps that the software sends. The
default string is public.

Sender OID

Controls which varbinds to include in the trap; all varbinds are included
by default. This option is not available when you select SNMPV2 on the
SNMP Version list.

SNMP traps can only include a IP or OID within the Header when for
SNMP Version 1 traps.

An OID is a dotted numeric string that identifies an object. Typical
objects that can be identified using OIDs include: attributes in
X.500/LDAP-based directories, certificate policies and practice
statements, MIBS for network management, and encryption algorithms.
Two objects are considered to be the same only if they have the exact
same OID.

Sender IP

Specifies the destination host name or IP address for sending traps. This
option is not available when you select SNMPV2 on the SNMP Version
list.

SNMP Version

Select from either SNMP Version 1 or Version 2.

Log Trap Sending to Logfile

Writes the event to a file.

Test It

Tests the settings. Remember to click the Apply button first, or Servers
Alive uses the previous settings.
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Other Mail (Setup Dialog Box)

Servers Alive can natively send mail using an SMTP server. If you are
not using an SMTP server, Servers Alive can still send mail using your
mail server, if you define a command line mailer for your mail system.

For each entry, you can define an alert that sends a message using Other
Mail. This alert has its own message and uses the send options defined
within the alert. For more information, see Send Other Mail (page 190).

Enable Other Mail

Click the check box to allow Servers Alive to send mail using the
command line mailer you specify.

Command Line

Defines the command line that the software uses. You can define an alert
for each entry that sends a message using these settings. The entry has its
own message. In the command line, you enter the command that Servers
Alive issues when sending mail with your command line mailer. Within
the command line, the %m is replaced with the actual message that
Servers Alive generates.

Test It

Tests the settings. You should receive a test message. Remember to click
the Apply button first, or Servers Alive uses the previous settings.

Registry Settings for Verifying Messages

You can modify the message that Servers Alive sends by adding or
editing the following registry value:
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Default To

Enter an ICQ number to which the alert message is sent. This is the ICQ
number for your account.

Default Message

Enter text for the body of the message. This is the default text for the alert
message. You can use the parameters listed in the previous description.

Test It

Tests the settings. You should receive a test message. Remember to click
the Apply button first, or Servers Alive uses the previous settings.

Reset

Resets the counter that tracks the number of messages that the alert sends
when completing a check. You can view the number of messages sent
since the last time that you clicked the Reset button.

Failure Settings

To display these settings, click the Setup button and then, in the tree,
click Alerts > ICQ, MSN Messenger, AIM (AOL Instant Messenger),
SNPP (Network Paging) or SMPP (Network Paging).

You can then click Failure Settings.

Use DUN Connection When LAN Connection Fails

Click the check box to allow Servers Alive to use the DUN connection
when the SNPP or SMPP network paging connection fails.
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DUN Entry to Use

Select the current DUN entry or _LAN_. If you have created dial-up
network connections on your computer, those connections appear on the
dropdown list.

The DUN feature is available only if a dial-up network connection is
installed on the computer running Servers Alive. See the online Help for
Windows for more information on how to create a dial-up network
connection. To use this feature effectively, Servers Alive must make the
connection completely unattended. For that reason, you must configure
the dial-up entry to save passwords.

Username

Enter the user name.

Password

Enter the user password.

Domain

Enter the domain.

MSN Messenger (Setup Dialog Box)

To use MSN® Messenger, you must install the high encryption pack
from Microsoft. To ensure that you have installed the pack, click Help >
About Internet Explorer in Internet Explorer. The About box should
display Cipher Bits as 128 bits or higher.

This feature works only with TCP protocol, not UDP or HTTP. No proxy
support is provided.
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Test It

Tests the settings. You should receive a test message. Remember to click
the Apply button first, or Servers Alive uses the previous settings.

Reset

Resets the counter that tracks the number of messages that the alert sends
when completing a check. You can view the number of messages sent
since the last time that you clicked the Reset button.

SMPP (Network Paging) (Setup Dialog Box)

If sending an SMPP alert by LAN (local area network) fails, Servers
Alive can send the alert through a DUN (dial-up networking) connection.
For more information, see Failure Settings (page 43).

Enable SMPP

Allows you to send messages over the Short Message Peer to Peer
(SMPP) protocol. Click the check box to enable the feature and enter
values on the dialog box.

SMPP Host

Enter the name of the host.

Port

Enter the port that you want to use. This option specifies the TCP/IP port
on the SMPP server that the gateway should connect to.
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Encoding Schema

Select from a list of options for encoding the message including: SMSC
Default, IA 5 ASCII, Cyrillic, 8 bit binary B, and so forth.

System Type

Specifies an optional parameter for logging in. This parameter should be
set only if required by the SMPP server. The system administrator
provides this value, which is usually a short text string.

System ID

Enter the user name, or system ID, for the gateway to use when
connecting to the SMPP server.

Password

Indicates the password for the gateway to use when connecting to the
SMPP server.

Many SMPP SMSC providers require specific parameters for SMPP.
Servers Alive uses automatic defaults for the TON and NPI values that
work for most SMPP connections. For more information about the
parameters you should use, contact your SMPP provider.

Bind TON

Select from several options including Unknown, International,
National, Net Specific, and so forth.

Bind NPI

Select from several options including ISDN, Data, Telex, and so forth.

If one of the following options is set, the values are used in place of the
automatic values determined by the software: SSource TON,
SDestination TON, SSource NPI, SDestination NPI.

SSource TON

Applies to the sender address that is associated with messages that are
submitted to the SMSC. Select from several options including Unknown,
International, National, Net Specific, and so forth.

Servers Alive automatically sets the SSource TON to 1 if the sender
address is in international format, or, rather, starts with a + character. If
the sender address is not in international format, Servers Alive sets the
SSource TON to 0. The software sets the SSource NPI to 1 in both
cases. If the sender address contains alphabetic characters and is not a
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Add/Edit Executive Alert Dialog Box

You can display this dialog box when you click the Add or Edit button
on the Executive Alerts branch of the Alerts tree on the Setup dialog
box.

The options of the What tab of the Add/Edit Executive Alert dialog box
are different, depending on the option you select when you click the Add
button. The following list shows the different settings that appear on the
What tab for each option:

What Tab: Send SMTP Mail (Primary) (page 186)

What Tab: Send SMTP Mail (Alternate) (page 191)

What Tab: Send Other Mail (page 190)

What Tab: Alpha Page/SMS (page 194)

What Tab: Send Network Page (SNPP) (page 196)

What Tab: Send Network Page (SMPP) (page 197)

What Tab: Generic NotePager-PageGate Message File (page 199)

What Tab: Numeric Page (page 200)

What Tab: Execute Command (page 202)

What Tab: Sound (page 208)

What Tab: HTTP(S) GET/POST (Add/Edit Alert Dialog Box) (page
209)
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Automatically Change the Name Every Month

Click this option to allow Servers Alive to rotate your log file every
month. The file is written to the Servers Alive product directory.

Automatically Change the Name Every Day

Click this option to allow Servers Alive to rotate your log file every day.
The file is written to the Servers Alive product directory.

Automatically Change the Name Every Hour

Click this option to allow Servers Alive to rotate your log file every hour.
The file is written to the Servers Alive product directory.

Log Options

Advanced Options

Path Used for Auto-Generated Logfiles

Enter the path that you want for the log file that is automatically
generated. By default, Servers Alive saves the log file, except for the
fixed name log, in the same directory as Servers Alive. You can change
this by entering the path that you want in the box.

Username

Enter the user name for the log file.

Password

Enter the password for the log file.

Registry Settings for Saving a Retrieved Web Page in the
Log File

When performing a URL check with a “contains” clause, Servers Alive
saves 150 bytes (by default) of the retrieved web page in the log file. You
can change how much is saved or changed by adding or editing the
following registry entry:

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\Log\HTTPBytesinLog (string)

A value of -1 means the full web page. Use this with care because your
log filewill grow very fast. A value of 0 defaults back to 150 bytes.

If you want to safeguard the Servers Alive logs against missing data due
to power failures or critical operating system errors, you can request that
Servers Alive close the log file each time the software writes to the log
file with the following registry entry:
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HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\Log\CloseEachTime (dword)

Value 1 forces Servers Alive to close the log file each time the software
writes to the log file. This value changes the default action.

To Database (Logfile) (Setup Dialog Box)

This feature is available only in the Enterprise edition and free version of
Servers Alive. It is not available in the Standard edition.

Enable Database Logging

Click the check box to enable this option.

ODBC Connection String

Enter the connection string for the Open Database Connectivity (ODBC)
database. Click the browse button to open the Create Database
Connection String dialog box (page 65) and select a data source. The
browse button is not available until you click the Enable Database
Logging check box.

You can also use UDL files for database logging. Because UDL files use
OLEDB providers, the files use memory more efficiently than ODBC
drivers. To create a UDL file, open Notepad and save an empty file as
<your_filename>.UDL. Double-click the .UDL file to open the Data
Link Properties dialog box and configure the UDL connection. To use
the file, enter the path to the UDL file as a connection string in the
ODBC Connection String box.

Table

Enter the name of the table for the database that you want to send
information to.
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Enter this name before you click the Create Table button.

Create Table

Click this button to create the database.

Registry Settings for Date and Time Format

You can define the date and time format for the database logging by
specifying the following registry entry keys. When the registry keys are
empty, the date and time format of the operating system are used.

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\Log\db_DateFormat

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\Log\db_Timeformat

Create Database Connection String Dialog Box

List of Data Sources Available

Name

Lists the type of databases available on your computer.

Driver

Lists the application drivers used to create the corresponding database.

Username

Enter the user name for logging in to the database.
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Use "DSN=" Syntax

Click this check box to create a connection string in the following syntax:

oConn.Open "DSN=mySystemDSN;" &"Uid=myUsername;" &
"Pwd=myPassword"

Password

Enter the password used to log in to the database.

Syslog (Setup Dialog Box)

Syslog is a standard method of centralizing various logs. You can use a
syslog server to store your Servers Alive logs in a remote location for
later perusal or long-term storage. If you want to use the Syslog feature,
there are various freeware syslog servers on the Internet. Syslog is an
established standard so Servers Alive works with any syslog servers.

For a Windows based syslog server, we recommend Kiwi Syslog
Daemon, available from www.kiwisyslog.com
http://www.kiwisyslog.com/.

You must enable syslog logging for each particular entry that you want to
log. It is not turned on for every entry by default. You should determine
if you want to use this service before adding many entries so that you can
turn it on as needed as you add entries.

Enable Syslog

Click to enable this feature and enter information on the dialog box.
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Syslog Host (Name or IP)

Enter an IP address for your server.

Port

Enter the port for your server. The port number is usually 514 unless you
are using a non-default port number on your syslog server. When you
have entered the server and port, click the Apply button and then the Test
It button. You can check the logs on your syslog server to verify that the
server is correctly logging events from Servers Alive.

Priority to Use When Entry Is

Specifies which entries are logged and how often they are logged.

Down

Specifies how to log an entry when the server is down. You can choose
from Emergency, Error, Alert, Critical, Warning, Info, Notice, and
Debug.

Up

Specifies how to log an entry when the server is up.

Maintenance

Specifies how to log an entry when the server is in maintenance mode.

Unavailable

Specifies how to log an entry when the server is unavailable.

When to Send

Always

Specifies that the log message should be sent on every check cycle.

Status Change

Specifies to send the log message only when the log status changes.

Options

Include RFC header

Adds RFC compliancy. This RFC compliant header adds information to
the message, such as date stamp of send, or who sent the message, and
the name of the process that sent the message.







70 Servers Alive Administrator's Guide

The Time Unit box determines how the software indicates how long the
entry was in that status: x minutes - x hours, and so forth.

Registry Settings for the Host Name

You can also edit the Windows registry to define whether to use the host
name:

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\StatsLog\AlwaysHostName (regdword)

0 - use the host name if no pretty name is defined, otherwise use the
pretty name.
1 - always use the host name.

To Database (Statistical Logging) (Setup Dialog Box)

This feature is available in the free version of Servers Alive and in the
Enterprise edition. This feature is not available in the Standard edition.

Export Statistical Logging to Database

Click the check box to enable this feature and enter settings on the dialog
box.

ODBC Connection String

Enter the connection string for the Open Database Connectivity (ODBC)
database. Click the browse button to open the Create Database
Connection String dialog box (page 65) and select a data source.

You can also use UDL files for database logging. Because UDL files use
OLEDB providers, the files use memory more efficiently than ODBC
drivers. To create a UDL file, open Notepad and save an empty file as
<your_filename>.UDL. Double-click the .UDL file to open the Data
Link Properties dialog box and configure the UDL connection. To use



File Menu 71

the file, enter the path to the UDL file as a connection string in the
ODBC Connection String box.

Table

Enter the name of the table for the database that you want to send
information to.

Enter this name before you click the Create Table button.

Create Table

Click this button to create the database.

Time Unit

Select the time unit used to indicate how long an entry has been in a
certain status before the status changed. The statistical logging creates an
entry, in the database, when the entry that is checked changes status; for
example: from up to down.

The logging includes the time the entry was in a previous status. So, for
example, when the status goes from up to down, the record shows the
time the entry was up before the server went down. The Time Unit box
determines how the software indicates how long the entry was in that
status: x minutes - x hours, and so forth.

You can define the date and time format for the database logging by
specifying the following registry entry keys. When the registry keys are
empty, the date and time format of the operating system are used.

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\StatsLog\db_Dateformat

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\StatsLog\db_Timeformat

Include Host ID

Click the check box to include the ID of the host server.

Include Cycle Start (yyyymmddhhmmss)

Select the check box to include the date and time for the start of the cycle.
The format is yyyymmddhhmmss. For example, 20041206093035 would
mean the cycle started at December 6, 2004 at 9:30:35 in the morning.

Registry Settings for Host Name

You can edit the Windows registry with the following registry key to
define the size of the host name, also known as the pretty name, within
the database for statistical logging:
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HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\StatsLog\db_prettynamesize (string)

You can also edit the Windows registry to define whether to use the host
name:

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\StatsLog\db_AlwaysHostName (regdword)

0 - use the host name if no pretty name is defined, otherwise use the
pretty name.
1 - always use the host name.

Interchange Data (Setup Dialog Box)

You can choose to export interchange data to either a file or, if you have
the Enterprise edition, a database. You can set options for either of these
two features.

To File (Interchange Data) (Setup Dialog Box)

This feature exports a result file after each check file that contains the
status of all entries. You must specify the file name, including the full
path, to which the export file is written.

The interchange log file is overwritten after each check cycle. You must
get the data after each cycle.

Export Interchange Data to File

Click the check box to enable this feature and enter settings in the dialog
box.
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File Name

Enter the name of the file to write the information to. Click the browse
button to select a file on the computer.

Command

Enter the command. Click the browse button to select a command file on
the computer. The command is executed after the interchange log file is
generated. You can use a command to insert the interchange data into a
database. However, this process is easier if you have the Enterprise
edition of Servers Alive.

Separator

Select the separator to use as a column delimiter in the log file. If the
separator that you select appears within the data that should be logged,
the software replaces that separator with an underscore _. For example,
you might select a comma as a separator. The Extra Info field contains a
comma, as follows:

Welcome, coming from IP 1.2.3.4

The software converts the comma in the Extra Info field to the following
text:

Welcome_ coming from IP 1.2.3.4

Fields to Include in Interchange Data

Click the following check boxes to include the information in the log.

Host Name

Includes the host name in the log.

Pretty Name

Includes the pretty name in the log.

Check Info

Includes information that is checked. For example, for an SMTP check,
the information could be (TCP port 25) - ping.

Extra Info

Includes the response on the check. For example, this information could
be "Service is running" or "404 not found error" for a URL check.
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Additional Info

Includes additional information in the log for the round trip or the time
necessary to complete the test.

Number of Cycles Since Start

Includes the number of cycles since the start. The UID is the unique ID
that Servers Alive assigns to each host entry. This UID cannot be
changed.

Host ID

Includes the ID of the host server.

Group ID

Includes the group ID.

Cycle Start

Includes the date and time for the start of the cycle. The format is
yyyymmddhhmmss. For example, 20041206093035 would mean the
cycle started at December 6, 2004 at 9:30:35 in the morning.

Remark

Includes a remark in the log file.

To Database (Interchange Data) (Setup Dialog Box)

This feature is available in the free version of Servers Alive and in the
Enterprise edition. This feature is not available in the Standard edition.
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Export Interchange Data to Database

Click the check box to enable this feature and enter settings in the dialog
box.

ODBC Connection String

Enter the connection string for the Open Database Connectivity (ODBC)
database. Click the browse button to open the Create Database
Connection String dialog box (page 65) and select a data source.

You can also use UDL files for database logging. Because UDL files use
OLEDB providers, the files use memory more efficiently than ODBC
drivers. To create a UDL file, open Notepad and save an empty file as
<your_filename>.UDL. Double-click the .UDL file to open the Data
Link Properties dialog box and configure the UDL connection. To use
the file, enter the path to the UDL file as a connection string in the
ODBC Connection String box.

Table

Enter this name before you click the Create Table button.

Enter the name of the table for the database that you want to send
information to.

Create Table

Click this button to create the database.

Fields to Include in Interchange Data

Click the following check boxes to include the information in the log.

Host Name

Includes the host name in the log.

Pretty Name

Includes the pretty name in the log. You can enter the size of the Pretty
Name in the box. If you enter or modify the size, recreate the table by
clicking the Create Table button.

Check Info

Includes information that is checked. For example, for an SMTP check,
the information could be (tcp port 25) - ping.
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Extra Info

Includes the response on the check. For example, this information could
be "Service is running" or "404 not found error" for a URL check.

Additional Info

Includes additional information in the log for the round trip or the time
necessary to complete the test.

Number of Cycles Since Start

Includes the number of cycles since the start.

Host ID

Includes the ID of the host server.

Group ID

Includes the group ID.

Cycle Start

Includes the date and time for the start of the cycle. The format is
yyyymmddhhmmss. For example, 20041206093035 would mean the
cycle started at December 6, 2004 at 9:30:35 in the morning.

Remark

Includes a remark in the log file.

Registry Entries for Date and Time Format

You can define the date and time format for the database logging by
specifying the following registry entry keys. When the registry keys are
empty, the date and time format of the operating system are used.

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\Interchange\db_Dateformat

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\Interchange\db_Timeformat

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\Interchange\db_sqlcmd_before (string) is the SQL command that is
executed before interchange records are added to the database.
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When the database reaches the maximum size, the new data overwrites
existing data at the beginning point.

Other databases store the values as supplied. RRDTools can calculate the
rate of change from the previous to the current value and store this
information instead.

Other databases get updated when values are supplied. The RRDTools
only needs data at pre-defined time intervals. If the database does not get
a new value during the interval, the database stores an Unknown value for
that interval. So, when using the RRDTools database, you must use
scripts that run at regular intervals to ensure a constant flow of data.

1 Click File > Setup. In the Logging > RRD Tools area, enter the
appropriate options.

2 In the main window, edit each entry to enable RRD logging. Click
Edit > Changes Wizard.

3 Click File > Setup.

4 In the Logging > RRD Tools area, click the Generate Create Script
and Generate Graph Script buttons to create the .bat files.

5 From the command prompt or a DOS window, browse to the database
directory and execute the Create script in the .bat file. Type
sa_create_rrd.bat. For each entry that has RRD logging enabled, a
database file is created.

6 To create the graphs after each cycle, enter the command in the
Command to Execute after the Update box in the Graphs area.
Type the directory path and sa_graph_rrd.bat.

Enable RRDTool Logging

Click to enable logging of data with the RRDTools.

After you enter your settings for RRD graphs and databases, you can edit
each entry to enable them for RRD logging. You can do this quickly by
clicking Edit > Changes Wizard. After you edit each entry, you then
click File > Setup and, in the Logging > RRD Tools area, click the
Generate Create Script and Generate Graph Script buttons.

Path to RDDTool

Enter the path where you installed the RRDTools. You should include the
.exe that you compiled.

By default, the RRDTools logging is completed in UTC (GMT) time.
You can change the logging time to the local time by editing the
Windows registry with the following key:

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\RRD\UseLocalTime (dword) to 1
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RRD Logging (Round Robin Database) (Setup Dialog Box)

Database Path

Enter the path where you want the databases stored.

Roundtrip RRD logging

Database Prefix

Enter the prefix for the names of all the databases. This ensures that each
database has a unique name. Once you enter the prefix, you should not
change it.

By default, Servers Alive creates and updates database files with the
name xy, where xy is the unique ID of the entry. For example, if you
want to name the database sa_xy.rrd, enter sa_ for the prefix and .rrd for
the suffix.

Database Suffix

Enter the suffix for the names of the databases. See the previous
paragraph.

For example, if you enter RRD for the prefix and .DB for the suffix, the
database for the entry with a unique ID of 4 is called RRD4.DB.

Checkresult RRD Logging

Database Prefix

Enter the prefix for the names of all the databases. This ensures that each
database has a unique name. Once you enter the prefix, you should not
change it.
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Generate Graph Script

Click to generate a script that creates the graphs of data in the databases.
You must run the .bat file to create the graphs. Servers Alive prompts you
to review or edit the contents of the .bat file in Notepad. Servers Alive
does not actually create the graphs directly.

The graphs are in .gif or .png format. You can include these graphs in
web pages.

Command to Execute After the Update

Enter a command to start Servers Alive updates to the RRDTools
databases. For example, you can enter the name of the .bat file that
Servers Alive generates to create the data graphs.

If you enter the data graph command and want to include the graph in the
Servers Alive HTML template-based output, you should click the Wait
Until Execution Is Completed check box.

Wait Until Execution Is Completed

Click this check box to ensure that the databases are updated before the
command executes.
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You can have one or more of the list. For example, status=DOWN,UP
gives only the entries that are up or down.

You can sort the entries for the page with the following tags. Sorting is
always by group by default and then by the parameter that you give
within the page.

sort=HOSTID,UID,NAME (or
HOSTNAME),CHECK,STATUS,PRETTYNAME,IP, ENTRYPATH

You can have one or more in the list; for example sort=name,check.

If you do not want to sort by group first, then set the nogroup option.

In the group My Entries, each entry is part of a group, or subgroup. The
full path is the ENTRYPATH, or the path to the entry:

group \subgroup\subsubgroup

When sorting the template-based HTML output by GroupPath or
EntryPath, you can edit the registry to set the number of bytes used by
those parameters:

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\StartUp\SortStringPathSize (string)

Not in the registry or =0defaults to 250. Above 1250 goes back to 1250.

Example Template

Carriage returns and line feeds are removed from outputs based on the
HTML template.

<!--This is the header section.-->

<BODY>

<!--Here the current date and time variables are used-->

<H4>Last check done on
<sa_currentlongdate>&nbsp&nbsp&nbsp<sa_currentlongtime>

<!—Add in a comment that notes that Servers Alive generated the page.--
>

<!-- Generator Servers Alive version <sa_version> via template....-->

<p>

<TABLE WIDTH="762" cellpadding="4">
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<TR><TD WIDTH="32" align="center"><FONT face="verdana"
size="2"><B>Up?</TD>

<TD width="20" align="center"><FONT face="verdana"
size="2"><B>ID</TD>

<TD width="130" align="center"><FONT face="verdana"
size="2"><B>Host</TD>

<TD width="280" align="center"><FONT face="verdana"
size="2"><B>Host Check</TD>

<TD width="80" align="center"><FONT face="verdana"
size="2"><B>Parameter</TD>

<TD width="70" align="center"><FONT face="verdana"
size="2"><B>Actual</TD>

<TD width="145" align="center"><FONT face="verdana"
size="2"><B>Time of Last Status Change</TD>

</FONT>

</TR>

<!--The core section begins here. It is repeated for every host on the
page.-->

<sa_report sort=status>

<!--Use SAIF to change the color depending on whether the host is up or
down.-->

<tr bgcolor="<saif sa_status is down>ff0f00</saif><saif sa_status is
up>dbdcaf</saif>">

<TD BGCOLOR="#ffffff">

<!--Use SAIF to display the correct icon (not supplied with Servers
Alive)

depending on the host condition.-->

<SAIF SA_STATUS IS UP><img src="images/running.jpg"></SAIF>

<SAIF SA_STATUS IS DOWN><img src="images/stop.gif"></SAIF>

</TD>
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<TD WIDTH=20 BGCOLOR="#8fbc8f">

<!--Display Host ID with SA_HOSTID.-->

<CENTER><FONT SIZE=2><sa_hostid></FONT></CENTER>

</TD>

<TD WIDTH="145">

<!--Display Pretty Name with SA_PRETTYNAME.-->

<FONT FACE=verdana SIZE=1><sa_prettyname></FONT>

</TD>

<TD WIDTH="280">

<!--Display the type of check with SA_CHECKDESCRIPTION.-->

<FONT FACE=verdana SIZE=1><sa_hostname>
(<sa_checkdescription>)</FONT>

</TD>

<TD WIDTH="80">

<!--Display check parameters with SA_THRESHOLD.-->

<FONT FACE=verdana
SIZE=1><CENTER><sa_threshold></CENTER></FONT>

</TD>

<TD WIDTH="70">

<!--Display the response time/data with SA_CHECKRESPONSE.-->

<FONT FACE=verdana
SIZE=1><CENTER><sa_checkresponse></CENTER></FONT>

</TD>
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<TD WIDTH="175" valign="center" align="center">

<!--Display the time of the last status change with
SA_STATUSCHANGETIME and SA_STATUSCHANGEDATE.-->

<FONT FACE=verdana SIZE=1><sa_statuschangetime>,
<sa_statuschangedate></FONT>

</TD>

</TR>

<!--End of the core section.-->

</sa_report>

<!--Beginning of footer.-->

</TABLE>

<BR>

<!--Display when the last check cycle occurred using
SA_CURRENTLONGDATE

and SA_CURRENTLONGTIME.-->

<H4>Last check done on
<sa_currentlongdate>&nbsp;&nbsp;&nbsp;<sa_currentlongtime>

</BODY>
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You can edit the Windows registry with the following keys to modify the
responses:

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\WAP\IncludeAllSmallResponse (dword)

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\WAP\IncludeAllLargeResponse (dword)

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\WAP\IncludeDownSmallResponse (dword)

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\WAP\IncludeDownLargeResponse (dword)

With a value of 1 it will add the response column too. (%e parameter)

To change the DOCTYPE header of the WAP file, edit the following
registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\WAP\WML_Version (string) with acceptable values: 1.1 or 1.2 or
1.3 or 2.0

Status Summary (Setup Dialog Box)

The Status Summary dialog box allows you to enter conditions for
sending a status summary message through the protocol that you want.
This is useful if you want to receive a quick, periodic update on your
servers.

Servers Alive can send an email to show the status of the entries by
email, paging, or instant message (IM).
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Load Startup Info from Registry

Click if you plan to have Servers Alive start automatically and read in a
saved list of monitored entries, which is required for operation as a
service. In the registry, Servers Alive stores the various startup options
and the name of the file containing information on what entries to check.

Hostfile

Specify where the saved file containing check information is located.
This file has not been created yet if you are reading through this
documentation for the first time, so you must refer to this information
again later, after you have created your list of entries.

Start Checking But Wait __ Seconds After the Start of the Program

Click the check box to enable Servers Alive to automatically start
checking when it is launched. Enter the number of seconds that you want
Servers Alive to pause before checking. This is useful if Servers Alive
runs as a service when the computer boots up, but you want Servers Alive
to wait for all local programs to finish launching before starting its check
cycle.

Start Minimized

Starts Servers Alive minimized, whether the software is launched through
the Programs menu or as a service.

Only Show Pretty Name in GUI

Shows only the pretty names in the software interface. Pretty names are
labels that you assign to your monitored items for easy recall.

Other Startup Options

Cycle Unit

Determines whether Servers Alive uses minutes or seconds as the cycle
unit. This time unit determines how long the software waits between
check cycles. You can specify settings for the check cycle on the Misc
Settings branch of the Settings dialog box tree.

Send Mail at Start/Stop of Checking

Click this check box to enable Servers Alive to send mail at the beginning
and ending of every check cycle.

Use High Encryption for Password Storage

Select this check box to ensure that passwords are stored with high, or
AES 256-bit, encryption settings.
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Cache IP Addresses and ___ Expire Them Every ___ Cycles

Ensures that Servers Alive stores the IP addresses in cache. Clear this
check box to ensure that Servers Alive does not cache the IP addresses.

This check box is selected by default. Thus, by default, the first time
Servers Alive checks a host using ping, TCP, or UDP, the software
resolves the name into an IP address. Each of the following times Servers
Alive checks your host, the software uses the IP address stored in
memory.

Click the second check box and enter a numeric value to determine how
many cycles pass before the IP addresses expire.

List of Public Holidays

Enter a list of public holidays. You must use the dd-mm-yyyy format
with a comma delimiter. For example, you can enter 12-25-2003 for
December 25, 2003.

You can use the Startup branch of the Setup tree to edit your list of
public holidays. These public holidays can be treated as a Sunday, rather
than whatever day they actually fall on, when Servers Alive determines
whom to alert. You turn that feature on when defining a person with the
Edit > People command.

You can change the way tabs on dialog boxes appear by editing your
registry with the following key:

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\StartUp\tabs_look (dword)

0 - tab dialog style
1 - property page style like Windows Properties dialog boxes

To reduce the amount of time that Servers Alive waits between two
checks, edit the following registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers
Alive\StartUp\PerItemCycle {string}

The default is 250 ms. Enter values starting at 10.
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Misc Settings (Setup Dialog Box)

Automatically Save Changes on Exit (to a File)

Click to save changes to a file. If the Automatically Save Changes on
Exit (to a File) option is selected, all changes made to the current entries
configuration are saved automatically. If the option is enabled and you
start a new set of entries, you are prompted for a file name when you exit
Servers Alive.

Load Windows Positions at Startup

Select to open Servers Alive in the same size and position that it had
when you closed the software. If Load Window Positions at Startup is
enabled, Servers Alive restores its last position on the screen and also
restores itself to the last known window size.

Send Keep Alive Mails Every __ Minutes

Enter the number of times that you want mails sent. You can request a
mail from Servers Alive every once in awhile as proof that it is still
running.

Automatically Restart Checking After __ Minutes

Specify how often you want Servers Alive to start checking in minutes.

Check Times (Every X Minutes)

Enter values in the grid to tell Servers Alive when to begin a check cycle
on your list of hosts. The check times indicate the time that is between the
end of a cycle and the start of the next cycle.
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This feature is available only in the free version and Enterprise edition of
Servers Alive.

Custom 1

Click this check box to enter information that defines your custom field.

Field Caption

Type the caption that you want to use as the name or label for the field.

Field Name in Database

Type the name that you want to use for the field in the database table.
You can use this name when writing a script.

Custom Scripts (Setup Dialog Box)

You can define the scripts that Servers Alive can use. The settings that
you can define include a filename, the function, and a description for that
function. For each entry that you define, you can specify that if the
output, or result of the check, must be converted using one of the script
functions, the %e parameter, included in the check result. You can write
scripts only in Visual Basic.

This feature is available only in the free version and Enterprise edition of
Servers Alive.
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Function HTTP_Response(x)
S=trim(x)
rcode=left(s,3)
select case rcode

case “200”
http_response=”All is going well with

the website”
case “404”

http_response=”The page you’re
requesting
is not available on this server”

case else http_response=x + “ (looks like
that isn’t within my case)” +
fields.sa_checkdescription

end select
end function

Filename

Displays the filename that contains the script. Enter information in this
column by clicking the Add or Edit button and typing the information in
the Scripts dialog box (page 113).

Function

Displays the code functions for the script. Enter information in this
column by clicking the Add or Edit button and typing the information in
the Scripts dialog box.

Description

Displays the description for the function. Enter information in this
column by clicking the Add or Edit button and typing the information in
the Scripts dialog box.

Add

Click this button to add a script to the list.

Remove

Click this button to remove a script from the list.

Edit

Click this button to edit information in the list.

Scripts Dialog Box

You can add scripts to the Setup options by clicking File > Setup and
then selecting General > Custom Scripts in the tree. Click the Add or
Edit button to display the Scripts dialog box.
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This feature is available only in the Enterprise edition of Servers Alive.

Filename

Type or click the browse button to enter the name of the file that contains
the script.

Function

Enter the function name of the script.

Description

Enter a text string that describes the script.

MIB Database (SNMP) (Setup Dialog Box)

Servers Alive can parse SNMP traps using a built-in MIBs (management
information base) database. A MIB database is a core tool for network
engineers: you can query a remote server or other device on your network
for hardware and software configurations using SNMP. This database is
useful for monitoring and collecting data about any specific device on
your network, if the device supports SNMP. For example, you can find
out what OIDs the remote server supports. The SNMP trap receiver can
perform OID lookups within a MIB database. And the SNMP check can
interpret the result it receives.

An OID is a dotted numeric string that identifies an object. Typical
objects that can be identified using OIDs include: attributes in
X.500/LDAP-based directories, certificate policies and practice
statements, MIBS for network management, and encryption algorithms.
Two objects are considered to be the same only if they have the exact
same OID.

MIB files are a kind of dictionary used to assemble and interpret SNMP
messages. Each type of device on your network has its own specific MIB
file. The MIB file defines the device as a set of managed objects or,
rather, values that the SNMP manager reads or changes. The MIB file
allows the SNMP manager to interpret trap messages from devices.

To interpret trap messages, the SNMP manager must access the MIB file,
which describes the format and content of the traps that the device can
send. To be available for the SNMP manager, the MIB file for each of
your equipment types needs to be installed, or compiled, on the SNMP
manager. Because MIB files are specific to the hardware, you must have
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the correct MIB for your hardware type, model, and version number. You
can get a MIB file from the equipment vendor.

In the grid, you can change the way the information is displayed. For
example, you can click each column heading to resort the information
alphabetically in either ascending or descending order. You can also
select a column heading and drag it to a different location in the grid to
change the order of the columns.

Name

Displays the name of the MIB file in the MIBs database for Servers
Alive.

Description

Displays information about MIB file.

You can resize the columns on the grid to see more of each column. Also,
if you point the mouse to a description in the list, you can see the entire
description in the tooltip that appears.

Show Aliases Too

Displays the Alias column. This can possibly slow down the software.

Add MIB

Allows you to import a MIB file into the Servers Alive MIBs database
with the Add MIBs to the MIB Database dialog box (page 116).
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With the browser dialog box, you can select only one MIB file at a time.
To add several MIB files at one time, use a wildcard * in the file name
that you enter in the box. For example, you can enter cis*.txt to add all
MIB files that begin with cis and end with .txt.

Add

Click to add the MIB file that you selected in the MIBs to Add box to the
MIBs database. You must enter a name in the MIBs to Add box before
clicking this button.

The results of the import action appear on the Summary tab. For
example, if the MIB file already exists in the Servers Alive MIBs
database, a message appears on the Summary tab.

The file name is not the MIB name. Two MIB files can have the same
MIB name and exist under two different file names. The MIB name is
stored inside the MIB file and appears in the list on the MIB Database
(SNMP) branch of the Setup dialog box.

You can add as many MIB files as you want without closing this dialog
box. You can select another MIB file in the MIBs to Add box and click
the Add button again.

You can also use a wildcard to add several MIB files at once. For
example, you can enter C:\MIBFiles\Mm*.mib to add Mm1628v2.mib,
Mm1628v3.mib, and Mm1628v4.mib to the Servers Alive MIBs database
all at once when you click the Add button. The list of all the MIB files
that match the wildcard in that directory appear in the results of the
import on the Summary tab.

When you add a MIB file to the MIBs database, Servers Alive
automatically creates an alias for the file by adding MIB to the name of
the file. The software removes dashes or underscores in the file name.
The following table shows some examples.

If you add this MIB file to the MIBs
database Servers Alive creates this alias

rfc1234 rfc1234mib

rfc-1234 rfc1234mib

rfc-1234-mib rfc1234mib

rfc_1234-mib rfc1234mib

Summary Tab

Displays the results of the import when you click the Add button. This
tab appears blank, until you import a MIB file into the Servers Alive
MIBs database. The tab then displays the results of the import and the
location of the MIB file.
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Dependency Tab

Displays the errors in dependency relationships that the software detects
when you import an MIB file into the Servers Alive MIBs database.
These errors often result when the MIB file is dependent on another MIB
file that does not already exist in the database. You must get the other
MIB file from the appropriate hardware vendor.

In the grid, you can change the way the information is displayed. For
example, you can click each column heading to resort the information
alphabetically in either ascending or descending order. You can also
select a column heading and drag it to a different location in the grid to
change the order of the columns.

When you add a MIB file to the database, Servers Alive tries to locate the
files on which the MIB file depends, if any. The software looks for
different versions of the file name. The following table shows examples.

If a MIB file depends on
The software searches for the dependent
file in the database with the following names

rfc-1234 rfc-1234, rfc1234mib

rfc-1234-mib rfc-1234-mib, rfc1234mib

rfc_1234_mib rfc_1234_mib, rfc1234mib

If Servers Alive cannot find the file on which the MIB is dependent, the
MIB file is not imported into the Servers Alive MIBs database.

Load Errors Tab

This tab displays errors that result from mistakes within the MIB file
itself.

Other Errors Tab

Displays errors that result from importing the MIB file into the Servers
Alive MIBs database.

Add Alias

Enter a string to add to the MIB file that is listed in the MIBs to Add
box. In certain cases, you might want to create an alias of your own. For
example, a file with an alias of rfc1234 might be referenced in other MIB
files as rfc1234mib. You might want to add that alias to the database.

When you add an alias, the new alias appears in the Alias column of the
Setup dialog box.
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To

Click the dropdown list and select a MIB file from the Servers Alive
MIBs database.

Add

Click this button to add the alias to the database. A MIB file can have
more than one alias.




